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ProSeries tax software is easy to use and can handle your client’s complex tax situations.  The 
extensive ProSeries in-product and online help assists you in answering your questions. Many of 
the federal and state government instructions are available from within the software with just the 
click of a button. IRS publications can be accessed from links within the tax help. Once the return 
is completed, the final review feature of ProSeries can reduce the time required for the review 
process and narrow the selection of forms targeted for a closer examination. E-filing a return in 
ProSeries, either individually or as a batch, is a straight forward process.  The ease of use of 
ProSeries and the readily available help can assist you in streamlining your tax preparation 
services. 

ProSeries Professional Tax Software 2008 is the version of the software that is used in this 
course.   
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There are recommended and minimum system requirements for installing ProSeries.  The 
recommended requirements allow ProSeries to run efficiently and should provide a high level of 
performance.  The minimum requirements should provide adequate performance on most 
computer configurations.  While ProSeries might run on configurations with fewer resources than 
listed in the minimum requirements, we cannot guarantee acceptable performance or 
compatibility. 

To find the current year’s systems requirements go to: 

www.proseries.intuit.com/products/professional/?view=sysreqs  

 

 

ProSeries can be installed from a CD or from a download from www.my.proseries.intuit.com.  In 
order to download the software, you must have already setup a MyProSeries account. 
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When you install ProSeries for standalone use, the options that you set affect the operation of 
ProSeries only on that computer.  ProSeries options allow users to customize specific features to 
better suit their needs.  

�������#���$%�����
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The setup wizard launches immediately following the first installation of ProSeries.  There are 
options to use the Options Setup Wizard for Express Setup or Custom Setup.  All of the options in 
both wizards are available through other methods. 
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Product licensing is a system that licenses the ProSeries software to an appropriate firm.  Product 
licensing uses the customer number and zip code with the information in Intuit’s records to deliver 
the following information to the ProSeries software: 

An unlimited use license for each ProSeries tax product and ProSeries electronic filing product 
that has been licensed for unlimited use, even if one or more of those products has not been 
installed yet. 

Licensing the product online is often completed during the initial installation. If any changes are 
made to the customer license (i.e. you buy additional products, etc) the license will need to be 
updated.  If for some reason your customer number or zip code has changed, these will need to 
be changed in the Tools>Options>General by selecting the customer information button and 
making the appropriate change. 
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To license your product manually go to Tools>License Products, when you see the following 
chose manual: 
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Once you press OK you will get the following screen: 

 

Follow the directions on the screen and then enter the activation code when one is generated. 
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Product updates come out periodically, and these updates are critical parts of the ProSeries 
program. There are various ways that you can receive the updates. 
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Updating from within the ProSeries program is simple and effective.  This does require an internet 
connection. 

From the menu, select Update, then Update Installed Products.  This will update any ProSeries 
form sets that are already installed (or were chosen to be installed) on your computer.  It will NOT 
install any form sets that you did not select during installation. 

In order to install any new formsets that were not initially installed in the program, go to 
Updates>Select and Download New Products.  You will see the following selection box: 

 

 

Checked products will be downloaded and installed if they are available.   
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You may sign on to MyProSeries and select download products.  You will see the following 
screen: 

 

 

Choose the current tax year and your product family such as 1040 and States. 

You will see a list of all currently available products.  Choose download and the product will be 
saved on your computer.  Please select a location that you will remember such as My Documents 
or My Downloads. 
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When you start the ProSeries® program, the first thing you see is HomeBase. ProSeries 
summarizes information about your client files in HomeBase. 

From HomeBase, you can: 

·  Start new client files 

·  Open previously-saved client files 

·  Print returns 

·  Backup client files 

·  Read important messages in the Message Center 

·  Use HomeBase views to see certain types of clients 

·   
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Because HomeBase is the starting point every time you open ProSeries, it is essential that you 
first understand its purpose and how to use it. 

The toolbar is probably the most commonly used function in HomeBase. Toolbar functions are 
covered throughout this guide as they relate to the various topics discussed. If you are ever 
unsure of what an icon on the toolbar does, simply hold your mouse cursor over it and the fly-over 
help provides a description.�

�

� ��Any function that can be performed from the Toolbar can also be accessed via the Menu bar, 

however not all menu commands are available via the Toolbar���
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To create a new client file, you can perform any of the following functions: 

1. Click the corresponding icon on the toolbar. 

2. Use the [Ctrl] + [N] keyboard shortcut. 

3. Select New Client from the File menu. 

4. Open an existing client by simply double clicking it from the Client View area. You can 
also highlight the file by clicking it once and then selecting Open Client from the File 
menu or use the [Ctrl] + [O] keyboard shortcut 
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The HomeBase View drop down list contains a default list of 
views that filter all of your client files by federal return type 
(1040, 1120, etc.). Only the federal products that you’ve 
installed are included in this list. For example, if you have not 
installed the 1065 product, it will not be listed.  

The following views are also included in the list by default 
when you install the federal 1040 product: 

·  EF Center 

·  Bank Products 

·  Client Analyzer Queries 

·  Additionally, the All Tax Returns View is included when 
you install any federal product. 
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The transfer procedure is a simple way to start a client's tax return or Client Organizer file, and 
saves data entry time. 

The following table lists the information that ProSeries transfers from the prior year return: 

�

Type of 
information 

What is transferred to the next year’s client files  

Tax data All relevant tax data from the prior year client files, including carryover 
data.  

Descriptions for data, such as interest and dividends, are transferred 
without accompanying amounts because the amounts change each year. 
Data that typically changes each year is not transferred.  

The ProSeries program transfers all tax form data (including amounts) 
from a current Client Organizer or TurboTax file to a client's current 
ProSeries/1040 client file. 

Supporting 
statements 

Supporting statement descriptions without amounts from the prior year 
client file.  

The ProSeries program transfers supporting statement descriptions and 
amounts from a current Client Organizer or TurboTax file to a client's 
current ProSeries/1040 client file. 

Notes Notes from the prior year client file if you previously selected Include 
Reminder Notes and Narratives in the Transfer section of the Options 
dialog box (or the Options Setup Wizard).  

The ProSeries program does not transfer notes automatically when you 
transfer data to the Organizer file or from the Organizer file. 

Passwords Master password, if you set one up in the prior year  

Electronic Filing password, if you set one up in the prior year  

Client-level passwords that you assigned to the prior year client files  

The ProSeries program also transfers client-level passwords from Client 
Organizer files to the ProSeries/1040 client files. 

To transfer data from one or more client files:  

1. If you have not opened the Transfer window or HomeBase, open HomeBase. 

2. Click the Transfer button on the HomeBase toolbar.    

��  Follow the on-screen steps to transfer one or more client returns��
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Transferring Tips: 

·  You can choose to transfer clients at any time you like. Some preparers transfer clients 
one at a time as to avoid cluttering HomeBase with returns they have not prepared and 
help determine clients that did not return from the prior year.  

·  Others prefer to transfer all clients at once so they can easily identify if a client is new or 
existing (i.e. If the client is not already in HomeBase, they are a new client), and use the 
Status or Last Modified column to determine which clients did not return from the prior 
year. 

�
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Before you backup client files, make sure there is ample free space on the disks where you are 
creating the backup copies. When you create a backup of a client file, the original client file is not 
affected. 

To backup one or more files to a diskette, zip or f lash drive: 

1. Select the client file(s) that you want to back up. 

2. Right click a client file and choose Copy/Backup. 

3. In the Copy/Backup Client Files dialog box, click the Set target directory button, 
and then use the Set Target Directory dialog box to select the target directory 
that you want. (The default target directory is the directory to which you most 
recently backed up client files.) 

4. Click Backup client(s). The selected client files are backed up in the target 
directory. 

� �To backup your files to a CD, use your CD burning software separate from the ProSeries 

software. You are not able to backup your files directly to a CD from within ProSeries. Some 
devices allow you to copy files directly from the Prowin08\08data folder to the CD drive using My 
Computer. Refer to the documentation you received with your CD device or contact the 
manufacturer for assistance. 



�(�

	 �
��	��� �
To restore client files that you previously backed up: 

1. Right-click the client list (or the area where your clients would normally appear) and 
choose Restore. 

2. In the Restore Client Files dialog box, select the appropriate source directory, a return 
type, and the target directory. The default target directory is x:\Prowin03\03data, where 
x represents the drive where ProSeries is installed. The default source directory is the 
directory to which you most recently backed up client files. If you haven’t backed up 
any client files, no directory is specified. 

3. Select the client file(s) that you want to restore. 

4. Click Restore client(s). The selected client files are restored in the target directory. 

�
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If you use a CD to backup, the process may mark all folders and files as "read-only." The 
ProSeries program must be able to write to the directory to read from it. Therefore, you may have 
to change the attributes of the folder (and all subfolders and files) in order for the program to read 
the backup directory. 

To restore files backed up to a CD: 

1. Copy the files from the CD to X:\Prowin08\08Data, where X represents the drive where 
ProSeries is installed.  

2. Highlight the copied files.  

3. Select Properties from the File menu.  

4. In the Properties dialog box, under Attributes, uncheck all the boxes except Archive.  

5. Click Apply, and then OK.  

6. Go to HomeBase and select the appropriate view for the type of returns to be restored.  

7. Select DataBase Maintenance from the HomeBase menu.  

8. In the HomeBase Reconciliation dialog box, click the Fix It button for files not currently 
found in HomeBase.  

9. Verify that the files to be restored are listed in the next dialog box and click OK. 
ProSeries will now import the files to HomeBase for your use. 
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For new and current users of ProSeries, we offer FREE client data conversions from many 
common tax programs. Our conversion manuals provide the necessary steps to have your data 
converted to ProSeries. In most cases, you will receive your converted data within 10 business 
days. 

We support data conversions from the following tax programs: 

·  ATX® ·  TaxWise Saber 

·  Drake ·  TaxWorks TaxView 

·  Great Tax  ·  UltraTax TaxWise  

·  Lacerte®  

·  ProSystem fx  

�

For complete details and links to the instruction manuals for converting your client data, go to 
www.proseries.com/resources/dataconversion.aspx. 

Our conversion teams convert your data to the prior year ProSeries format. You can then use the 
transfer feature to carry client data to the current year program. 

 �    We only convert the necessary client information required to complete the current year 
return. We do not convert every single piece of information. Please refer to the list of Conversion 
Items in each conversion manual to determine which items convert to the current year ProSeries. 
You should carefully review your converted data files to be sure your converted data is accurate. 
If you have items that did not convert, manually enter them in the current year return. 
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This section discusses ways to navigate among the forms, schedules, and worksheets that are 
required to prepare each client's return(s). You will also learn where and how to begin the data 
entry process. 
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The Forms Bar on the left side of the ProSeries window is designed 
to help you navigate between forms in a return quickly and 
efficiently. 

All the forms in a product are logically grouped into various 
expandable and collapsible sections. Some of the sections are 
further broken down into expandable and collapsible subsections. 

The following general sections are displayed for most of the federal 
products and the larger state products.  

·  Forms in Use is a dynamic list of all of the forms that are 
included in the currently open return. This section is 
included in all the products. 

·  Common Forms is a set list of the most common forms, for 
the currently opened product (1040, 1120S, Arizona 
Corporation, etc) 

·  General Info is a set list of forms that collect general 
information data pertaining to the type of return that is open. 
This section is further broken down into expandable and 
collapsible subsections. 

�
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The following sections are displayed for a 1040 return. Many of them are common to other types 
of returns, but the list of forms in each, would vary. Business and state products display different 
sections that are customized for them, but the functionality and purpose are the same. 

 

·  EF & Banking  is a list of all forms that is necessary for 
electronically filing or for using Bank Products. 

·  Income  is a list of all forms that is necessary for entering or 
calculating income data. This section is further broken down 
into subsections including Wages, Interest & Dividends, 
Business Income, etc 

·  Adjustments  is a list of all forms that is necessary for 
entering or calculating items that could end up being reported 
on Form 1040, Adjustments to Income section.  

·  Deductions  is a list of all forms that is necessary for entering 
or calculating items that could end up being reported as an 
Itemized Deduction on Schedule A. 

·  Credits  is a list of all forms that are necessary for entering or 
calculating the various credits that are possible in a 1040 
return. This section is further broken down into subsections 
including Child-Related, General Business, etc. 

·  Taxes is a list of all forms or worksheets that are necessary for entering or calculating the 
various taxes that are possible in a 1040 return. This section is further broken down into 
subsections including AMT, Household Employees, Kiddie Tax, etc. 

·  Tax Payments  is a list of forms and worksheets on which various tax payments can be 
entered. It does not include such forms as W-2 or 1099s. Those are included in the 
Income section. 

·  Miscellaneous  is a list of forms and worksheets that do not fit into another category. This 
section is further broken down into subsections such as Preparer & Billing, Planning, etc 

·  Reports & Summaries  is a list of reports and summaries that are generated from the 
creation of a 1040 return, including Schedule C Two-Year Comparison, W-2 Summary, 
etc. 

·  All Forms  is a complete list of all of the forms in the product. This section is included in 
all products. 
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If you prefer to use the keyboard rather than the mouse, you can perform most functions in the 
program using shortcut keys. A complete list of available shortcut keys is provided in the 
Appendix of this guide. 

One of the most widely used shortcut keys is [F6] — used to access the Open Forms dialog box. 

You can then use the hotkeys to open the forms. Each form has it’s own hotkey indicated by blue 
lettering. If you type the wrong letter, press [Backspace] and retype it. 

�

Once you have opened the Open Forms dialog box. Type the hotkeys for the desired form and 
press [Enter] to open the form that is currently highlighted. 

�
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There are many different ways to prepare a return in ProSeries, and the order in which you enter 
client data will differ based on each situation. However, there are some general guidelines that 
you can apply. 

The most important question to ask yourself when you’re unsure of where a piece of information 
should be entered is “Where would this go if I were doing the return manually?” Once you know 
where the data is to end up on the 1040, you can use the tools discussed later in this chapter to 
drill-down.  
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ProSeries provide a list of category sheets at the top of the forms bar to 
help step you through the process of preparing a return. These can often 
prove helpful when you’re not sure where to start. Each category sheet 
contains a list of QuickZooms along with descriptions for each piece of 
information you should enter. 

 �    Category sheets may not be all-inclusive and you should always 

review the return to ensure accuracy. 

��-
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For help completing the steps to prepare a tax return in ProSeries, you can use the table in the 
ProSeries® Users Guide under the Introduction section. It outlines the features and workflow that 
you can use to create returns from start to finish. 
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This section describes the 3 primary tools you use while entering tax return information��
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Use QuickZooms to go to the source form and line for the active field. You can also use 
QuickZoom to open another form.  

There are two types of QuickZooms: 

·   QuickZoom buttons  are incorporated into some forms and all Category 
sheets. Click a QuickZoom button to open the form, schedule, or worksheet that supplies 
information for the current form. QuickZoom buttons never appear as part of a line 
although they may sometimes support one. 

·  In certain fields a QuickZoom icon   appears on the left or right side of 
the field, and "QuickZoom" appears on the status bar. Click the QuickZoom icon (or 
double-click the QuickZoom field), to quickly open the form, schedule, or worksheet that 
supports the selected field. 

 

 �    After you QuickZoom to a form, you can return to the original form by pressing [CTRL] + 

[TAB], or by using the arrow buttons on the toolbar.  

�
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When viewing a tax form line that receives data from other forms and worksheets, you can right-
click that line and use Cross Reference to see how the amount in the current line is computed.  

If the Cross-Reference command isn't available, the 
calculated value is probably based on information 
on the active form. Read the instructions for that tax 
form line to determine how the amount is calculated. 

Alternative to QuickZooms, Cross-Reference is 
designed to provide information about the 
calculation of a line, making this feature a 
troubleshooting and review tool. QuickZooms are 
designed to take you to the data entry point for a 
line. 
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Some forms contain one or more expanding tables. Use expanding tables to enter lines of data 
without having to go to a separate worksheet. When you select a field within an expanding table, 
the table becomes active. An active expanding table has a thick border and a scroll bar. 

�

�
�

�
 
As you enter data in an expanding table, the table scrolls to accommodate for more information. 
When you print a return, ProSeries prints as many lines of data on the form as possible and prints 
the "overflow" data on a supporting statement. 

 �    The Edit menu includes the following commands that you can use with expanding tables:  

·  Sort Data in Table 

·  Delete Line in Table 

·  Insert Line in Table 

Part III of the Federal Information Worksheet is an 
example of an Expanding Table. 

Expanding Tablesheet is an example of an Expanding 
Table. 

Use the scrollbar on the right 
to review all entries in the 

table. 

When you are not entering data 
into a table, “more” appears in the 
last entry if there are more lines 
than the table displays by default. 
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The ProSeries® Help Center 
is the central location to find 
answers to questions you 
may have regarding any 
feature or function in the 
program. 

Below are examples of some 
of the help topics available. 
Be sure to come back here 
and review the remaining 
topics in your own time. 

The Tax Help provides 
instructions for a form, 
schedule or worksheet from 
Intuit’s software developers. 

Government Instructions are 
the instructions given to 
Intuit’s developers from the 
taxing authorities. 

The Research Library is a 
separate product containing 
indexed, searchable, detailed 
IRS Publications, Form 
Instructions and many other 
helpful research topics. 

Since ProSeries does not 
provide a hard copy User’s 
Guide, you can access the 
electronic version here. 

 

You can also email Technical Support through the Help Center. 

��    The left navigation pane of the Help Center is usually hidden by default when you open a 

help topic. To view the choices discussed above, click the title bar of the Help Center window. 

�
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The Help Toolbar is located near the top of the screen and includes the following features: 

·  Field/Form Help (when a return is open) 

·  Most Common Support Questions 

·  Search Help content 

When you’re working on a return, the left side of the Help Toolbar shows some information about 
the currently selected field or form. When you click the blue, underlined word “more” near the 
bottom-right corner of the Field/Form Help area of the Help Toolbar, all of the relevant Field/Form 
Help information appears in the Help Center���

�

�

�

The contents of the Help Toolbar changes depending on whether you are in HomeBase or an 
open return. The Help Toolbar is not available when you are in certain specialized windows (such 
as the Transfer and Print Preview windows). 

The far left side of the Help Toolbar displays information about the currently selected line on the 
tax form, schedule or worksheet. 

Using the search feature on the right section of the Help Toolbar you can search the ProSeries 
Help Center for answers to your questions.  

 �    This includes questions about using ProSeries or tax related information. 

Most Common Support Questions are questions that are listed in the middle of the Help Toolbar. 
Most Common Support Questions are context-sensitive, so the questions change as you move 
around the program. Each Most Common Support Question is “linked” to an answer in Program 
Help, Tax Help, Government Instructions, Quick Answers, or the ProSeries User’s Guide. 

Click a question to see the answer. Click More near the bottom-right corner of the Most Common 
Support Questions area of the Help Toolbar to see more timely relevant Most Common Support 
Questions. The program displays the top 10 questions in this list. 
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Available in the 1040 and 1065 products, the Where Do I Enter feature can help you find the 
correct form to enter particular information.  Selecting the Where Do I Enter button on either the 
right side of the toolbar, or above the Forms Bar or clicking on the blue underlined text “Can’t find 
a form…” on the Forms Bar will result in a dialog box appearing.  

�

By typing a word or phrase in the Search: window search results will display in the dialog box. 
The Search is dynamic and can change as you type. Clicking on any of the Search results will 
take you to the form that is displayed in the right column of the Search results window. 

 �    The search is not case sensitive. 
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Use the Missing Client Information feature to track specific information that certain clients didn't 
provide when they delivered their information for the current tax year. 

From a client's federal or state return, you can use the Missing Client Information feature to:  

·  Record descriptions of information that clients have not yet provided. 

·  Link descriptions of missing information to fields on forms. 

·  E-mail detailed reminders to clients. 

·  Print detailed reminders to mail to clients or for your use. 

·  Go directly to the fields that you previously linked to descriptions of missing information. 

·  Track information that you've received and recorded. 

 

In HomeBase, clients with missing information are identified with a red exclamation mark in the 
Missing Client Information column.  

�

�
 

From HomeBase, you can:  

·  Sort clients in a HomeBase view according to the Missing Client Information column. 

·  Enter or edit descriptions of missing information. 

·  E-mail detailed reminders to clients. 

·  Print detailed reminders to mail to clients or for your use. 

·  Batch print the detailed reminders for multiple clients. 
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While you are in a client’s return, you can tag various fields to indicate that information is missing 
for that field. You can also make general notes for information you still require for completing the 
return without linking it to a specific field in the tax return. 

This feature is available for all ProSeries federal and state products including the Organizer. 

To record descriptions of missing information: 

1. If you want to link the description of the missing information to a specific field on a form, 
go to the appropriate form and select the field where you will be entering the missing 
information. 

2. Go to the Tools menu and choose Add/Edit Missing Client Info to open the Missing 
Client Information dialog box. 

3. You'll see "<Enter items here>" on line 1 in the Missing Information column. Do either 
of the following: 

·  If you selected a field, click the Link to Field button to link the Missing Information item to 
the selected field on the form. If the field is available for linking, the program enters a 
description of the field. That description will be blue and underlined to indicate that it is 
linked to a field on a form. 

·  If you don't want to link the Missing Information item to a selected field on a form, or if the 
selected field isn't available for linking, type an appropriate description in the Missing 
Information column. That description will be black and not underlined. 

If you want to record descriptions of additional information, you can keep the Missing Client 
Information dialog box open while you enter data on forms. Select the next field that is 
missing information, and then select the next blank field in the Missing Information column of 
the Missing Client Information dialog box. When you are finished click OK. 
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Be sure to save the client's return, which also saves the information in the Missing Client 
Information dialog box��

�
You also can press [F11], or go to the toolbar and click the Missing Client Information button to 
access the Missing Client Information dialog box. 

�

You may wish to modify the default description ProSeries creates when linking missing 
information to a field. Your client(s) may not always understand the technical terminology used by 
the program. Also, when wording your descriptions, keep in mind how they will appear when you 
print or e-mail a summary of this missing information for a client. 

�    To delete a line item, click it once and press [Delete]. ProSeries removes it from the list as 

though it never existed. 
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To help you remind your clients of the information you require for completing the return, you can 
generate an e-mail or a letter to send to your client. This can only be performed for one client at a 
time. 

To print or e-mail a Missing Client Information Sum mary: 

1. From within a client’s return, go to the Tools menu and choose Add/Edit Missing Client 
Info. 

2. Click the Print/Email button in the Missing Client Information dialog box. 

3. Edit the fields in the Print or Email Missing Client Information dialog box if necessary.  

�  The FROM Email Address, TO Email Address, and Subject fields cannot be blank if you are 

sending an e-mail. 

4. Click the Print button if you want to print the client's Missing Client Information 
Summary. 

5. Click the Email button if you want to e-mail the Missing Client Information Summary to 
the client. 

If the program successfully launches your e-mail application, it enters the Missing Client 
Information Summary into a new e-mail message. The e-mail won't be sent until you click "Send" 
in your e-mail application. 

�    To print a Missing Information Summary for multiple clients: From HomeBase, select Print 

from the File menu and choose Print Missing Client Info from the left navigation bar in the Print 
Center dialog box. 
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When a client provides previously-missing information, take the following steps to enter that 
information in the client's return(s) and to update the information in the client's Missing Client 
Information dialog box. 

To indicate missing information has been received:  

1. Open the client's federal return. 

2. Go to the Tools menu and choose Add/Edit Missing Client Info. 

3. If the description for previously-missing information that you've received is blue and 
underlined, select the description, click the Go to Field button, then enter the 
information that the client provided. If the description is black and not underlined 
(because it's not linked to a field on a form), go to the appropriate form, then enter the 
information that the client provided in the applicable field(s).  

4. In the Missing Client Information dialog box, indicate that you received the information 
by clicking the appropriate box in the “Received?” column. 

5. If the client's Missing Client Information dialog box includes descriptions of information 
that you need to enter in the client's state return, go to the toolbar and click the Go to 
State button. 

 �    If the box in the “Received?” column is checked for every item in the client's Missing Client 

Information dialog box, you won't see a red exclamation mark for that client in HomeBase, and 
the Missing Client Information dialog box won't open automatically when you open the client file 
or run Final Review. 
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ProSeries does not visually “flag” a line for missing information when you are using the Missing 
Client Information utility. There are a couple of additional tools you can use as a supplement to 
this feature. 

If you are unsure about any input field, you can enter a figure to make the calculations work and 
mark it as estimated to indicate that you still need to verify the accuracy of that amount. The data 
you entered becomes red and in italics. Also, any lines calculated from that amount are shown in 
italics. To mark a field as estimated, press [F8] or select Mark As Estimated from the Edit menu. 

Notes & Find/List Notes can be a helpful tool for identifying information you still require from the 
client, communicating that information among your staff or making narrative notes to include with 
the tax return. Notes are not included when you are filing that return electronically. Attach notes to 
a line by right-clicking the field and selecting Add/Edit Note. Find all notes in the return by 
selecting Find/List Notes from the Edit menu. 

The client checklist  feature can help you avoid missing information by informing your client of 
the necessary information they need to provide you to prepare their returns.  It provides your 
client with a personalized list of items based on their prior year tax information.  The client 
checklist can be accessed from within the client file from the Tools Menu.
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In addition to ProSeries extensive in-product help, there is also a Live Community that can be 
accessed from within the program.  In Live Community you can present your questions to other 
tax practitioners and get their responses.  You can also assist other tax practitioners by 
answering their posted questions. 
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This section covers some of the major data entry areas in ProSeries and what you can expect 
when using them. The objective is to increase your understanding of how to enter data into the 
various forms, schedules and worksheets in ProSeries��

� ���	��� � ���	!������ ' �	2
���� �
Use the Federal Information Worksheet to collect most of the general taxpayer information, such 
as name, address, social security number, dependent information, etc. in one convenient place. 
The information you enter here transfers to other related forms or schedules you use to prepare 
the return. 

 �    This worksheet is an integral part of the program. If you bypass this worksheet and enter 

information directly on a form or schedule, the program does not work properly. Do not override 
information on other forms or schedules that was originally entered on this worksheet. Return 
here to make all necessary changes��

�
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To enter or edit preparer or ERO information access "Firm/Preparer Info" by selecting Options on 
the Tools menu. 

Enter the preparer's code that matches the code entered on the Firm/Preparer Info for the paid 
preparer for this return. The program carries that preparer’s information to the tax return and to 
the Client Invoice. To remove the firm and preparer information and print "Non-Paid Preparer" or 
"Self Prepared" in the Paid Preparer signature area on the tax return, check the appropriate box. 
The program enters "XNP" or "XSP" in the preparer's code field. 

�
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If you transferred information from last year's return, be sure to review the information for direct 
deposit or electronic funds withdrawal for applicability in the current year. 

If your client's tax return shows a refund and you check the box to elect direct deposit, ProSeries 
carries the direct deposit information (routing number, account type, and account number) to 
Form 1040 (or Form 1040A or 1040EZ if applicable). If you check No or leave the field blank, X’s 
appear on lines 74 b and d of Form 1040 in place of the Routing/Account numbers.  

	��*����������-,����-��*��
An exception to the passive activity rules is if the taxpayer or spouse is a qualified real estate 
professional working in a real property business. If the client qualifies for this status, their rental 
real estate activities might qualify to be treated as non-passive activities. To indicate that this 
client qualifies for this status, mark the box in “Part IX – Other Information”, at the bottom of the 
Federal Information Worksheet��Refer to Publication 925 and the ProSeries Tax Help for more�
information��

�

After marking the Real Estate Professional box, you must determine on a property by property 
basis if the taxpayer “Materially Participates” in that activity & mark the material participation box 
if he does. (The criteria for material participation can be found in the ProSeries tax help.) 
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Enter the two-letter abbreviation for the state where the taxpayer lived on the last day of the 
calendar year. Then check the appropriate box to indicate whether they lived in that state the 
entire year or only part of the year. ProSeries uses the entries here to determine what type of 
state return to complete: resident, part-year resident, or nonresident. 

 �    Complete this section before entering client tax data; however do not complete the income 

allocation worksheets until you have finished the return. 

If a client must file returns to more than one state, prepare the client's non-resident state return(s) 
before you prepare the client's resident state return. The ProSeries program automatically 
calculates the tax credit offered by a resident state on non-resident income, so you don't have to 
enter that information into the client's resident state return manually��

�

If the client was a part-year resident of any states, click the first QuickZoom button below the 
table to go to the Part-Year Resident State Allocation Worksheet. 

If the client was a nonresident of any states, click the second QuickZoom button below the table 
to go to the Nonresident State Allocation Worksheet. 
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Use this worksheet to enter information from Forms W-2. All data from this worksheet is 
summarized on the W-2 and W-2G Summary worksheet. 

A multi-copy dialog box always appears when you open a form in which multiple copies of the 
same form could be required.  

�

�

When a multi-copy dialog box appears you have the option of performing one of the following 
tasks: 

·  Select an existing form to open. 

·  Create a new copy of the form you are opening. 

 

 �    A quick way to create a new copy of a form is to type the employer name in the field at the 
bottom. 

When you prepare a state return, ProSeries transfers the state wages and taxes withheld when 
you enter the appropriate two-character State ID code in Box 15. ProSeries also transfers city 
and local income tax withheld if you use the appropriate Local ID code and associated State ID 
code. See ProSeries help for the supported local codes. 
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Check Box to Calculate Automat ica l ly  

Check this box if you want ProSeries to calculate the amount for the following boxes: 

·  Box 3, Social security wages 

·  Box 4, Social security tax 

·  Box 5, Medicare wages/tips 

·  Box 6, Medicare tax withheld 

·  Box 16, State wages (if only one state) 

�

�� ���If you check automatically calculate box and then later make entries for deferred 

compensation in box 12 or non-taxable combat pay, the amounts in boxes 3, 4, 5, and 6 will 
change accordingly while the amount in box 1 stays the same. 

Once you check the box, ProSeries calculates all of the above amounts. If you have already 
entered an amount in any of the above fields, the calculation will not write over that amount. 

If you want to show an amount different from that calculated in a particular box, you can enter the 
correct amount without unchecking the box. Once you enter an amount in one of the fields, it will 
not recalculate. You can, however, cause the field to recalculate by deleting the entry you made 
in that field. 

Be sure to check all calculated fields against the actual W-2 for accuracy. There are many 
situations in which ProSeries calculates an amount different from that on the W-2. See the Cross 
Reference for each individual field for more detailed information on how each of the above fields 
is calculated��
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You can enter your client’s depreciation related information using one of the 4 types of entry 
worksheets that ProSeries offers: 

Use this form:  to enter This type of asset information: 

Form 2106 Vehicle Expenses 
Worksheet 

Only vehicles relating to Form 2106 Employee Business 
Expense. 

Form 8829 Asset Entry 
Worksheet 

Only assets relating to Form 8829, Expenses for Business use 
of a Home. 

Car & Truck Expenses 
Worksheet 

Only vehicle expenses and depreciation information relating to 
Schedules C, E, F, K-1 Partner, K-1 S-Corporation and Forms 
4835. 

Asset Entry Worksheet All other depreciable and amortizable assets relating to 
Schedules C, E, F, K-1 Partner, K-1 S-Corporation and Forms 
4835. 

 

This section does not cover the Form 2106, Vehicle Expenses Worksheet. The data entry for this 
form is essentially the same with a few exceptions including but not limited to: 

·  There are 2 columns to enter vehicle information instead of 3 columns like the Car & 
Truck Expenses Worksheet. Only 1 asset can be entered on each copy of an Asset Entry 
Worksheet. 

·  The Change Activity function is not available on the Car & Truck Expenses and Form 
2106 Vehicle Expenses Worksheets. 

 

You can create as many copies of any depreciation entry worksheet as you need. ProSeries 
completes Form 4562 and Form 4797 as required based on your entries on these asset 
worksheets. 

 �    ProSeries only prints Form 4562 with the filing copy of the tax return when there are assets 
are marked as listed property or placed in service in the current year. See the Government 
Instructions for information about who must file this form.   



�/�

����������+�'-�3�#����
You must use a separate copy of the Asset Entry Worksheet for each asset and identify each 
asset with a specific activity. 

This worksheet does not print with the return, because the information on it appears on other 
reports. If you want to print it, open the worksheet on the screen, and then select Print from the 
File menu.  

 

After you enter the information on the Asset Entry Worksheets, the program carries information to 
the other depreciation worksheets and reports, the form or schedule you are working on, and 
Form 4562 (Depreciation and Amortization). 

Date Placed In Service (Required field): 

Enter the date placed in service and select a Depreciation type based on this date. 

Cost or Basis (Required field): 

Enter the appropriate cost or basis. When entering real property, if you choose to include the cost 
of any land, be sure to enter the cost of that land in the Land included in cost field as well. If you 
do not include the cost of any land, leave this field blank. 

Type of Asset (Required field): 

If you select Type of Asset A through Q, the program enters most of the other information on this 
worksheet. The default settings are explained on the help screens for Type of Asset A through Q 
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below.  If you select type O, Other, for the asset type, you must enter the other data to get the 
depreciation amount to calculate. 

 �     While the Type of Asset list continues to display the AMT recovery periods that applied to 
MACRS assets placed in service prior to 1/1/99, the program automatically uses the regular tax 
recovery period when computing AMT depreciation for assets placed in service after 12/31/98.  

For assistance in selecting the appropriate asset type, consult the Tax Help. 

 

�
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The Car and Truck Expenses Worksheet is used to determine the deductible vehicle expenses, 
using either the standard mileage rate or the actual expense method. The program compares the 
vehicle expenses using both methods, and selects the method giving the larger deduction. 
However, you always have the option of forcing either method. 

The program transfers the vehicle expenses to the related activity. If you are using the actual 
expense method, the program also transfers any Section 179 and/or depreciation deductions to 
Form 4562, if required, and to other Depreciation Reports and Worksheets.  

�

�
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Line 3, Type of Vehicle: 

Select a type of vehicle from the list. If the vehicle was placed in service after 1980, the program 
completes the rest of the depreciation information. 

Line 8, Percentage of Business Use: 

The program divides line 5 by line 4 (then multiplies the result by line 9 divided by 12 months, if 
line 9 has an entry). If the percentage of business use has changed from last year, the 
depreciation calculations handle the change automatically. Do NOT change your entries for Cost 
or Prior depreciation because of a change in the percentage of business use. If business use 
drops from above 50% to 50% or less, see the Tax Help for more information. 

Lines 23 and 24, Standard Mileage vs. Actual Expenses: 

The program uses the larger of the two amounts unless you force a method by checking box 23 
or 24. 

For vehicles owned by the taxpayer and used for business in a prior year, they must have elected 
to use the standard mileage rate in the first year the vehicle was used for business. 

�
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The Asset Life History is one of several Depreciation Worksheets and Reports used to list and 
summarize depreciation and amortization items. No input is required on this form.  

 �    ProSeries assumes the same business use percentage in the current year when calculating 
all prior and future year deductions, NOT what was actually deducted. If the business use 
percentage or any other information has changed from prior years this is not reflected in the 
computations here. 

This history shows depreciation and amortization information for each year of the assets life, 
while the Depreciation Reports only have current year and next year information. ProSeries lists 
these Depreciation Reports below the depreciation entry worksheet (Depr entry wks) in the forms 
bar (or the open forms dialog). 

�

Use the QuickZoom icon on the Asset Entry Worksheet, Car and Truck Expenses Worksheet or 
the Vehicle Expenses Worksheet to access the Asset Life History. 

When you access the Asset Life History by QuickZooming from the Car and Truck Expenses 
Worksheet or the Form 2106 Vehicle Expenses Worksheet, you can view the vehicle information 
for a particular vehicle by entering the column number for the vehicle whose asset life history you 
wish to view. 
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Many states have different depreciation rules than the IRS, and also different than other states. 
Instead of entering depreciation information on the Asset Entry Worksheet in the federal return, 
and then making adjustments in the state return, you can allocate amounts to the state returns�
easily in the State Depreciation section for each asset��

�

To add or delete states from this expanding table, click the QuickZoom to select or delete states. 
ProSeries opens Form 4562 Depreciation Options Worksheet. Use the expanding table to select 
additional states. 

State Sect ion 179 Deduct ion:  

The program will initially default to the full amount of Section 179 expense claimed on this asset 
for Federal purposes. Error messages will alert you if you need to adjust this amount on current 
year assets due to a different limitation at the state level. You can reduce your state Section 179 
elections for each state on each asset worksheet. 

State Special  Depreciat ion Al lowance:  

The program computes this amount automatically, based on the Federal eligibility and elections, 
and the applicable state law. 

State Prior  Depreciat ion:  

If state prior depreciation is different from Federal prior depreciation, enter the state amount here. 
Do not include any Section 179 Expense deductions or any Special Depreciation Allowance 
claimed. 

Inc lude Asset  Ad justment  In State Return:  

Check the "No" box here if the adjustment for Federal and state differences on this asset should 
be excluded from the state return for any reason. If "No" is checked, the full Federal deduction will 
be picked up for state purposes. 

 �    All state adjustments based on the differences between federal depreciation and each 

state’s depreciation rules are automatically calculated, based on the chart at the bottom of the 
Depreciation Options Worksheet. 

�
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If you discover that a supporting form or worksheet is not linked to the correct form, you can 
quickly change the link: 

1. Go to the supporting form or worksheet. 

2. Go to the Forms menu and choose Change 
Activity. 

3. In the Activity Type dialog box, select the 
activity to which you want to link the supporting 
form or worksheet, and then click Next. 

4. If the multiple-copy form dialog box appears, 
select the correct copy of the multiple-copy 
form, and then click Finish. 

 

 �    When a linked form is open, the name of the open form and the form to which it is linked 

appears on the title bar at the top of the ProSeries window.��

�

The Change Activity option is not available for the Car & Truck Expenses Worksheet or the Form 
2106, Vehicle Expenses Worksheet. In this case, re-key the asset information on a new 
Worksheet. 
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ProSeries does not support the automatic calculation and allocation for sales of business property 
combined into a single transaction (also known as “Bulk Sale” transactions). There are two 
options for you to work around this limitation in the program: 

Allocate the sales price in a consistent manner among the assets and dispose of each one 
individually. 

Open each asset worksheet included in the sale, and enter only a date of disposition 
without a sale price (NOT even a ZERO) this stops the depreciation up to that date of 
disposition without calculating a gain/loss for each asset individually. Then open a copy 
of the Enterable 4797 and enter the combined, “Bulk Sale” transaction information.  

�

�

 

�

��    The Enterable 4797 is available just below Form 4797, page 

2 in the forms bar. 

Enter the Date of Disposition, but leave the Sales price 
blank. Otherwise, ProSeries calculates the Asset 
Gain/Loss. 
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ProSeries provides K-1 worksheets for entering K-1 information from Partnerships, S-
Corporations and Estates/Trusts. You will also find supplemental expense worksheet for the 
Partnership and additional information worksheets for Partnership and S-Corp K-1’s located�1�	��
below them in the forms listing��
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You can import data into a ProSeries/1040 return from the Schedule(s) K-1 in the following types 
of returns: 

·  Prior year ProSeries/1041 - if a fiscal year return 

·  Current year ProSeries/1041 

·  Current year ProSeries/1065 

·  Current year ProSeries/1120S 

 

The import procedure is based on matching the Social Security Number for the beneficiary, 
partner, or shareholder on the Schedule(s) K-1 in the ProSeries/1041, ProSeries/1065, or 
ProSeries/1120S client file with the Social Security Number for the taxpayer (or the Social 
Security Number for the spouse if a Married Filing Joint return) on the Federal Information 
Worksheet in the Form 1040 return. 
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To import Schedule K-1 data from a ProSeries client  file: 

1. From within the Form 1040 return into which you want to import K-1 data go to the 
Import menu and select K-1 Import. 

2. From the K-1 Import menu, select 1065: Partnership, 1120S: S Corporation, 1041: 
Estate/Trust, or Fiscal 1041: Estate/Trust. 

�

3. In the K-1 Import dialog box, select the applicable ProSeries/1065, ProSeries/1120S, or 
ProSeries/1041 client file and click Open. 

4. The next K-1 Import dialog box shows the name of the client file from which Schedule K-
1 data will be imported and the name of the taxpayer into whose Form 1040 return the 
Schedule K-1 data will be imported. Click Import. 

Note the following about the K-1 Import procedure: 

·  Carefully review imported data for accuracy. 

·  Edit data that was imported to a Schedule K-1 Worksheet directly on the Schedule K-1 
Worksheet. 

·  There isn’t a command to delete K-1 Imported data, so you must manually delete data 
that was imported to a Schedule K-1 Worksheet. 

·  If you entered estimated data on a Schedule K-1 Worksheet in a client’s Form 1040 
return before you used the K-1 Import command to import Schedule K-1 data to that 
Schedule K-1 Worksheet, the program will not import data to the fields with estimated 
data. If appropriate, you can delete the estimated data then use the K-1 Import command 
again to repeat the K-1 Import procedure.  

·  If a field doesn’t contain any data (including fields from which you deleted data), the 
program will import data to that field if applicable. 

·  If a field contains manually-entered data (including imported data that you subsequently 
edited), the program won’t import data to that field. 

·  If a field contains data that was imported by the first K-1 Import procedure, that data 
remains unchanged. 
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�� ���Data that was imported to a Schedule K-1 Worksheet is aqua in color on your screen. If 

you select a data field with imported data, you’ll see “Converted Value” on the right side of the 
status bar at the bottom of the ProSeries window. 

At-Risk Limitations: 

When completing Schedule C, Schedule E, Schedule F, and Form 4835 activities, mark the “at-
risk” checkboxes based on whether each investment is partially or completely at risk. Also, any 
prior year at-risk suspended losses for the activity should be entered as a loss in the current year 
on the activity form. For example, on Schedule C enter the carryover amount on the Other 
Expenses line. 

 �    For Schedule K-1 activities enter any prior year at-risk carryover losses on the Schedule K-1 
At-Risk Limitation Allocation Worksheet related to the activity. Available via the QuickZoom button 
at the top of the corresponding worksheet 

�
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Schedule K-1 Partnership: 

� �

Schedule K-1 S-Corp: 

�
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Then complete Form 6198 to figure how much loss from an activity you can deduct. ProSeries 
displays the result from Line 1 of the Form 6198 Disallowed Losses Smart Worksheet on lines F 
of the Activity Summary Smart Worksheets. The Activity Summary Smart Worksheets are located 
at the bottom of the forms listed above.  

ProSeries also displays the At-Risk Status on line B of the Activity Summary Smart Worksheets. 
This may read “Part” or “All”: 

!������*��������%���-��
A trade or business activity is not a passive activity if the taxpayer materially participated in the 
activity. See the ProSeries Tax Help for Form 8582 or IRS Publication 925 for assistance 
determining the Material Participation tests.  

ProSeries provides checkboxes on each respective form for you to indicate whether each activity 
meets the Material Participation Tests. 

Schedules C, E, F and Form 4835����������#��������$������$����������&!�2�������!�� ��
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�
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� �You must use separate K-1 Worksheets if there is an entry on more than one of the boxes 1, 

2, or 3. 
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The ProSeries program helps save you time by automatically flowing applicable data from the 
federal return to the state return(s). 

To make sure that each return is accurate, complete the federal return before you start the state 
return. 

To open a state return, click the ST icon on the toolbar, or select Go to State/City from 
the File menu. 

If you used the ProSeries state product to prepare your returns last year, and you transferred 
data from a prior year ProSeries client file to the current year federal return, the Transfer Last 
Year's State Data dialog box appears when you open the state return for the first time in the 
current year. 

If you click Don't Transfer, the ProSeries program only transfers applicable data from the current 
federal return to the state return, and then displays the state's information worksheet. If you 
subsequently save the state return, the prompt to transfer last year's state data does not appear 
again. If you decide later that you want to transfer data from the prior year state return, remove 
the current state return, then create the current year state return again by clicking the ST icon on 
the toolbar. Any data you have entered will be lost. To remove a state return, choose Remove 
State/City from the File menu. 

�

If you click Transfer State Data, the ProSeries program transfers applicable data from the current 
federal return to the current state return, then transfers pertinent data from the prior year state 
return to the current year state return. Some examples of items that transfer include Estimated 
tax payments paid in the prior year and any amounts applied to estimated payments from an 
overpayment��

�
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You can create returns for more than one state from the federal return, when applicable. 
For example, you can create a New York state return and a New Jersey state return for 
a client if you installed both states. 

ProSeries automatically calculates the tax credit offered by a resident state on non-
resident income, so you do not have to enter that information into the state return 
manually. 

To prepare multiple state returns for a client: 

1. Prepare and complete the federal return. 

2. Prepare and complete the client’s non-resident state return(s). 

3. Prepare the client’s resident state return. 

4. If you change any data in the client’s non-resident state return(s) later, open the client’s 
resident state return so the ProSeries program can update the credit for taxes paid to 
non-resident states in the resident state return. 

 �    See the section on the Federal Information concerning part-year and nonresident state 

return filing.  If more than one state has been installed, you can easily move between states while 
in a state return by simply clicking the ST icon on the toolbar and selecting the next state you 
want to prepare.  
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One copy of the Part-Year Resident State Allocation Worksheet is available in the 
ProSeries/1040 product. The purpose of this worksheet is to indicate how various income and 
adjustment amounts reported on the client's federal return should be allocated to each of the 
client's part-year resident state returns. For a married couple, there are separate fields for the 
taxpayer and spouse��

�

Before completing this worksheet, you must list every state tax return that is required this year in 
Part X of the Federal Information Worksheet (including any nonresident state returns, if 
applicable). The calculations on this worksheet are activated when one or more part-year resident 
state returns are entered. It is best to complete this worksheet once the federal return is 
otherwise complete. 

The purpose of this worksheet is to: 

·  Split income items and adjustments into periods of residency in different states. 

·  Identify the state of source for an allocated amount, where applicable (for example, rental 
property and Schedule C businesses could be located in a different state). Only certain 
items require this entry. 
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Multiple copies of the Nonresident State Allocation Worksheet are available in the ProSeries/1040 
product. The purpose of each copy of this worksheet is to identify the portion of various income 
and adjustment amounts reported on the client's federal return that should be allocated to the 
client's nonresident state return. For a married couple, there are separate fields for the taxpayer 
and spouse. 

 �    Only use this form if you do not have any part-year resident state return. Otherwise complete 
the Part-Year State Allocation Worksheet only and include nonresident information��

�

Use this worksheet when a taxpayer is required to file a state tax return as a nonresident. There 
will be one worksheet for each nonresident state. 

Just the same as completing the Part Year Resident State Allocation Worksheet, you must list 
every state tax return that is required this year in Part X of the Federal Information Worksheet. 
The calculations on this worksheet are activated when one or more nonresident state returns are 
entered. It is best to complete this worksheet once the federal return is otherwise complete��

If the taxpayer happens to be a part-year resident of other states, amounts on this worksheet can 
be calculated based upon your entries on the Part-Year Resident State Allocation Worksheet. 
Otherwise, you should enter the desired allocation amounts in the right-hand column. If there is 
an amount in the left-hand column (Federal Amount) and the right-hand column is left blank, it is 
assumed that none of the federal amount is to be allocated to the current state. 

 



���

����
���������	���	��

To demonstrate the end-to-end process of completing a tax return in ProSeries®, this section 
covers the final steps in this process. 

�
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The Final Review feature provides you with a comprehensive review of the return. After you 
complete all the forms, use the Final Review feature to help you check the return for potential 
problems. The Final Review results appear in category-specific dialog boxes. Run Final Review 
until every reported situation is resolved to your satisfaction. 

Final Review cannot guarantee that a tax return is complete or accurate. As the preparer, you are 
responsible for entering all information required by the IRS or the state taxing authority and 
ensuring that the tax return is correct. 
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Use Final Review to locate and correct errors in the federal return, then use Final Review to 
locate and correct errors in the state return(s), if any. (Final Review is not available for Client 
Organizer.) 

1. From the client’s federal or state return, choose Final Review on the Information menu. 

2. Select the desired Final Review categories.  

3. Click Review. 

 

�  To quickly start Final Review, press [F5] or click the Begin Final Review  button on 

the toolbar���
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The results of the Final Review process are presented individually in the Final Review window 
(below the toolbar).  

Final Review information is grouped according to the categories that you selected in the Final 
Review Categories dialog box. Each category begins with an explanation of the category. 

ProSeries assigns each message to one of the following three priority levels"�

�

Click Next to see the next information in the Final Review window. When you click Next, you see 
either: 

·  The next error for the current category 

·  An explanation of the next category 

·  An explanation that you’ve reached the end of the Final Review 

 

If Final Review determines that there are no situations to report for a category, when you click 
next the explanation of the following category appears. 

When an error is identified in the Final Review window, the applicable form and field appear 
below the dialog box. 
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When you open a return that has an Electronic Filing status of “Failed Final Review” (in the Status 
column of the EF Center), the ProSeries program automatically starts Final Review��

To correct reported errors: 

1. ProSeries automatically takes you to the field that needs corrected. If you move off that 
field, the button in the lower left corner of the Final Review window can take you back to 
the error quickly 

�

2. After you enter or correct the data for that field, click Next to move to the next error. 

3. Repeat the process until you have corrected all the reported errors. 

4. The ProSeries program informs you when you reach the end of the Final Review. Click 
Recheck if Final Review indicates that there are still errors to fix. 

5. Click Finish when you are confident that all errors have been corrected. 

 �    The Recheck button does not appear in the Final Review window until you have reached the 

end and cannot click Next any longer.  
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The program creates a standard Client Letter that provides information and instructions to the 
taxpayer. The program can print this letter when you print a complete tax return.  

You can also create a separate custom Client Letter for any specific return. 

When you print the return, the program inserts specific information from the return(s) into the 
letter, omits sections that do not apply, and prints the customized letter along with the tax return. 
For return-specific items, the program uses Insert Codes that “pull” the information from the 
clients return. This allows you to use the same letter for all of your clients. 

State instructions are included in the letter automatically unless you have specified to exclude a 
state in Part XI of the Federal Information Worksheet. 

To indicate when you want to print the Standard or Custom Letter: 

·  Select Print Options from the File menu to open the Print Center. 

·  Select Print with Return from the left navigation bar. 

·  Check the appropriate column(s) to indicate which letter you want to print and the 
appropriate copy to include it in.  

�

�
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You can print returns from an open file, or you can print returns for one or more clients from 
HomeBase. 

To print a federal return, go to the File menu and choose Print. In the Print Selected Returns 
section of the Print Center, select one or more of the available options, and then enter the 
number of copies that you want for each return format that you select. 

To print the client's state or city return with the federal return, select State/City in the applicable 
sections (Tax Returns for Filing Copy, Tax Returns for Client Copy, and Tax Returns for Preparer 
Copy). If the Choose button is available, click it, and then select the client's state and city returns 
that you want to print. 

Select: To print: 

Tax Returns for 
Filing Copy 

A fileable copy of the client's return(s), plus attachments that you selected in 
the Print with Return section of the Options dialog box or Print Center. 

Tax Returns for 
Client Copy 

All forms, schedules, and worksheets containing data and that are a part of 
the client's copy of the return(s), plus attachments that you selected in the 
Print with Return section of the Options dialog box or Print Center. 

Tax Returns for 
Preparer Copy 

All forms, schedules, and worksheets containing data and that are a part of 
the preparer's copy of the return(s), plus attachments that you selected in the 
Print with Return section of the Options dialog box or Print Center. 

�� ���If you are using the tax product on a pay-per-return basis and you have not authorized the 

client's returns yet, the Return Authorization dialog box appears so you can authorize payment for 
the returns. 
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The information in the Control Which Forms Print section of the Options dialog box or Print 
Center (along with the information in the returns) determines which forms, schedules, and 
worksheets are printed for the client.  

Forms are printed in the order required for submission by the IRS or appropriate state agency. If 
you want to change the order, go to the Change Print Order section of the Options dialog box or 
Print Center.  

To change or view the printing options from the Print Center, click the Print Options button��
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You can print a specific form from an open return, but you cannot print a specific form from 
HomeBase. 

To print a specific form: 

1. On the File menu, choose Print, and then select Print Selected Forms in the left side of 
the Print Center dialog box. 

2. The default selection is the active form. To print the active form only, enter the number 
of copies and click Print. 

3. To select other forms, click Selected Forms, and then click Choose. 

4. Click the name of the desired form. To choose more than 
one form, hold down the [Ctrl] key and click the desired 
forms. 

5. Click OK. 

6. Enter the number of copies that you want and click Print. 

 �    You can quickly print the form you have on screen by right 

clicking an area of the form other than a line and select Print from 
the menu that appears. 

�
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In addition to our technical support team and website help, ProSeries Program Help can help you 
troubleshoot common printing problems. 

1. Select Help Center on the Help 
menu or press [F1]. 

2. Select Program Help on the left 
navigation bar. 

3. Click Printing from ProSeries under 
the “Filing Returns and extensions” 
heading on the right. 

4. Click Troubleshooting printing 
problems under the 
“Troubleshooting” heading on the 
right. 

�

�

�
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The first step in electronic filing is to apply to participate in the IRS E-File Program. Upon 
approval, the IRS will issue an EFIN, the “Electronic Filing Identification Number.” This is the 
number that is used on all electronically filed returns and indicates that the ERO is accepted in 
the E-File program. You can download this form from the IRS’s website, ProSeries.com or 
complete the form from within the 1040 program. 

Once you have been assigned an EFIN number you do not need to file again unless there is 
either a change to the business information such as an address, phone number or your EFIN has 
been inactive. A year without a transmission could be considered an inactive EFIN. We suggest 
checking with the IRS if this is your situation. 

�-�.�;<==�

Although you should use IRS e-services to apply to participate in the e-file program, you 
can also use form 8633 provided in the program. 

Use the following guidelines to complete Form 8633,  line 2:  

·  Line 2a - Check Yes  

·  Line 2b - Check the appropriate boxes based on the services provided by your business.  

·  Line 2c - Check No  

·  Line 2d - Check No  

·  Line 2e - Check No  

·  Line 2f - Check No  

 

The IRS accepts the 8633 year-round; however we strongly recommend filing this form by 
December 1st, to help ensure you receive your EFIN in time for the filing season. 

Once you have submitted the 8633, the IRS does standard checks to see if there are any issues 
with your personal tax history or with returns you may have prepared for someone else. 

For additional information or questions regarding Form 8633, please contact the IRS at 1-866-
255-0654 or visit their Web site www.irs.gov. 
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All states now recognize IRS approval of an Electronic Filing Originator.  Therefore no separate 
registration is required. 

�
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From ProSeries.com, you can check the status of your returns outside of the ProSeries software. 
Open any web browser and type www.proseries.com  in the address line. Search the ProSeries 
website for “Check E-file Status”. 

 

This tool may come in handy when: 

·  Your client asks you about the status of their return, but you do not have access to your 
ProSeries software, but do have access to the internet. 

·  If you feel like you should have received an acknowledgement from the IRS and the 24-
48 hour timeframe has passed, this tool allows you to determine if there is a technical 
issue with your software by checking the status outside of the program itself. 

The information provided to you on the website comes directly from the Intuit Electronic Filing 
Center Servers. It is real-time. 
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ProSeries Electronic Filing is integrated throughout the ProSeries program including certain 
forms, schedules and worksheets as well as error checking and setup functions. 

In this section you will learn: 

·  How to access and use the electronic filing related program options 

·  Where to enter your EFIN and PIN numbers so they flow to the appropriate forms and 
schedules 

�
��
-&�����

This counter keeps track of the current Declaration Control Number (DCN). Each return is 
assigned a unique DCN. The DCN counter starts at 00001, and ProSeries automatically 
increments the DCN counter as it assigns DCNs to returns and extensions.  

Recommendation: We recommend that you do not change the number in the DCN counter. (See 
the exception below.) If you change the number in the DCN counter, two client returns may be 
assigned the same DCN. Duplicate DCNs increase electronic filing processing time and cause 
returns to be rejected. 

When to change the DCN counter:  If your firm will be filing returns and extensions electronically 
from more than one computer using the same EFIN (and these computers are not networked), 
before preparers start to transfer data or prepare returns, change the starting number in the DCN 
counter on all but one computer. For example, advance the DCN counter to 01001 on the second 
computer, to 02001 on the third computer, and so on.  

By doing this, each return that's marked for electronic filing is assigned a unique DCN. 

 
A unique DCN is required for every tax return. The DCN is automatically computed by the 
program. The second part of the DCN is the ERO's EFIN, and the third part is assigned�when you�
check the Federal Electronic Filing box�

�

� �You only need to use the checkbox to “Automatically change the DCN” if you are resolving an 

issue with a duplicate. 
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Check if you are participating in the IRS Practitioner PIN for E-File program. (If you're 
participating in the IRS Practitioner PIN for E-File program, you don't need to mail any papers 
(such as Form 8453) to the IRS after you electronically file a client's return.)  ProSeries will 
automatically mark all new clients accordingly on the Federal Information Worksheet when you 
check the box in this section of the Options. 

���.���)����%�������,-�.���-��

Use the Firm/Prep Information section of the Options dialog to enter your EFIN and PIN numbers. 
Enter your EFIN number in the Firm Information section and each preparer’s PIN in the 
Preparer/ERO Information section. 

A federally-issued EFIN is required to file returns electronically. Enter the firm's federal electronic 
filing identification number (EFIN). This number does not transfer from the Contact Information 
automatically. ProSeries enters your EFIN from the Firm/Preparer Information on the various E-
File related forms and worksheets for tax returns marked for electronic filing. 

If multiple preparers in your office have their own EFIN enter it in the line next to their name and 
identification numbers. If not number is entered the program will use the EFIN entered at the top 
of the options screen as the default. 

�
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The 42 states and the District of Columbia that offer electronic filing are grouped into three 
categories as follows: 

·  Independent States. California, Illinois, Maine, Massachusetts and Minnesota and returns 
do not need to be electronically filed with the corresponding federal return. (New York is 
not an Independent state this year.) 

·  Federal/State states. Hawaii and Oklahoma returns must be filed with the corresponding 
federal return. 

·  Federal/State or State/Only states. Returns for the 35 states that are not Independent 
States or Federal/State states, and returns for the District of Columbia, should be 
electronically filed with the corresponding federal return, but they can be filed without the 
corresponding federal return. 

Select the appropriate states from the Select state(s) to file electronically expanding table in the 
Electronic Filing area of Part IV–Filing Information of the Federal Information Worksheet. The 
State(s) column shows a pick list of all 42 states that offer electronic filing, plus the District of 
Columbia. 

ProSeries and most states support state-only electronic filing this year, which means you can 
electronically file more than two state returns for 
a client. The only limitation is with the states 
that do not support State-Only electronic filing, 
which includes Hawaii and Oklahoma. 

All state returns that you select in the Select�
state(s) to file electronically expanding table on 
the Federal Information Worksheet are listed 
directly below the client’s federal return in the 
HomeBase EF Center. All state returns—except 
Hawaii and Oklahoma state returns—can be 
transmitted to the Intuit Electronic Filing Center 
without the corresponding federal return.  

� When transmitting your clients’ returns for the 
first time, we recommend you transmit the 
federal and all state returns at the same time. You may need to transmit a state return separate 
from the federal if: 

·  The federal was accepted, the state was rejected, no changes need to be made on the 
federal, but state adjustments are required and you wish to re-file the return 
electronically. 

·  You have already transmitted the federal return, it was accepted, you now wish to E-File 
the state return and you have not made changes to the federal since it was transmitted 
and accepted. 
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In addition to filing federal individual returns and extensions as well as most state individual 
returns, ProSeries also supports the following business returns/extensions. Business return 
electronic filing is essentially the same as in the individual tax return product. The key difference 
is in how attachments to the return are handled. This is described later in this chapter. 

You can find a list of the supported business retur ns via the following url: 

http://proseries.intuit.com/products/professional/ppr.jsp  

The setup for filing business federal and state returns is identical to individual returns. You are 
still required to enter an EFIN. The PIN program is also available. Federal business tax returns do 
not, however, require a DCN. 
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The IRS requires that you capture specific forms or information in PDF files that you then attach 
to the client's return before you file it electronically if you're not participating in the IRS Practitioner 
PIN program or your client doesn't want to use a PIN.  This only currently applies to business tax 
returns.  Since individual returns use a different efile system, PDF files cannot be attached. 

� PDF's may still be required whether filing with a PIN or not, as other supporting 

documentation may be required for the return... Do not use the Attach PDF feature to attach 
statements or explanations to the return. 

The IRS requires a description for each item that is attached to an electronically-filed return. 

The program enters the IRS-mandated description for certain attached items, such as Form 8453 
and Form 8283. You can enter a description for 'Other' attached items. 

If you need to attach a form such as Form 8453 to a return, take the following steps after you've 
completed the client's return: 

1. Print the form 

2. Obtain the required signatures 

3. Scan the form into a PDF-format file 

4. Attach the PDF file to the return 

�
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You should use this section in the options to add new or edit existing employers/payers. 
ProSeries automatically appends this section in the options with each employer/payer you enter 
on respective worksheets. This information also transfers from the prior and future years 
automatically. 

You can use the W-2 Employers section of the Options dialog box for the following purposes: 

·  Enter W-2 employer information if several of your clients received a Form W-2 from the 
same employer 

·  Enter W-2G payer information if several of your clients received a Form W-2G reporting 
gambling winnings from the same payer. 

·  Enter 1099-R payer information if several of your clients received a Form 1099-R 
reporting income from the same payer 

·  Enter 1099-G payer information if several of your clients received a Form 1099-G 
reporting income from the same payer 

�

When you prepare a Form W-2 Worksheet, Form W-2G Worksheet, Form 1099-R Worksheet, or 
Form 1099-G Worksheet, enter the Federal ID number before you enter the employer or the 
payer name and address information. 

If that Federal ID number matches a Federal ID number in the W-2 Employers section of the 
Options dialog box, the program enters the appropriate information about the employer or payer 
in the required fields. 
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Use the Electronic Filing Information Worksheet as a guide to enter the information needed to file 
returns electronically. Most of this worksheet is already completed for you. 

�
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To designate a different ERO than the paid preparer designated on the Federal Information 
Worksheet, enter the preparer's code that matches the code entered on the Firm/Preparer Info for 
the ERO in the Electronic Return Originator Information section. 

 

If you assign a non-paid preparer to the tax return, the program defaults to the first preparer 
associated to the main firm in the Firm/Preparer info as the Electronic Return Originator. If you 
would like to designate another ERO, enter a preparer code in this field. 

If your firm is only the ERO and did not prepare the return being transmitted, click on the 
magnifying glass in the last field in the Paid Preparer Information section to go to the 
Alternative Firm/Preparer Info to enter the information  



(/�

�-�.�;?@=�
Starting in Tax Year 2007, a signature is no longer required on Form 8453. It is to be used 
exclusively for attaching required signature forms (e.g. 8283 appraisals, etc.). All tax returns must 
use the paperless PIN program. 

The mailing address to file Form 8453 is provided on the 8453 itself and is determined based on 
the ERO's EFIN in addition to the client’s address��

 

If you are using the client status worksheet, the following dates you enter there will calculate to 
this section: 

·  Date the return was E-Filed 

·  Date Form 8453 was mailed to the IRS 

ProSeries does not otherwise complete these lines automatically.  However when the IRS 
accepts the return, ProSeries does enter the Date Accepted.  

If you select Tax Returns for Filing Copy in the Printing dialog box, the ProSeries program prints 
the appropriate electronic filing forms with the client’s return��
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This is the signature form used for electronically filed returns. The pin is represented on this form 
and transmitted with the tax return. 

EROs must provide this form to taxpayers and retain a signed copy on file for 3 years after the 
due date of the return. This signed copy can be an original or facsimile copy and stored physically 
or electronically 

��

�
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Very helpful if you are new to e-filing, this worksheet guides you 
through the entire data entry process of preparing an E-File 
return using QuickZoom icons. 

�  After you use a QuickZoom, hold [CTRL] and press [TAB] to 
return to the EF Category Sheet and continue with the steps 
listed. You can also use the arrow icons on the toolbar���
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All ProSeries Federal and State, individual and business products that offer electronic filing 
include a Preparer Electronic Filing Instructions form that is made up of three sections: 

1. The first section identifies the client, shows the DCN (Declaration Control Number) for 
the return and the date that the electronically filed return was accepted. 

2. The second section identifies steps that must be completed before the return is 
transmitted, and shows information about the return. 

��  The third section identifies steps that must be completed after the return is transmitted 
and accepted, and shows information about the return��
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"Which forms can be filed electronically?" found in the Most Common Support Questions.  To find 
this, you must be in a return.  This link will reference the type of return you are in, Federal or 
State depending upon what return you have open at the time��

��
Will my notes and supporting statements transmit wi th my electronic return? 

Notes and Supporting Statements (which are attached by right clicking on a line) are never 
converted. Supporting information can be entered as Preparer Notes if it needs to be part of the 
converted file. The hotkeys are “PN”. 

�
�Federal and state business returns do not contain a Preparer Notes form. The Attach PDF 
feature also should not be used to attach notes to an e-file return.  



+��


 �!������������ 	 ���	� �

����*�	����1��
To check the return for possible errors and omissions, go to the toolbar and click the Final Review 

 button.  

Select all options (including Electronic Filing) in the Final Review Choices dialog box, and then 
click Review. 

�

Correct any detected errors, then run Final Review again until you’ve corrected all detected 
errors. 
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On the Information Worksheet for the client’s state return, make sure the Electronic Filing box is 
checked. 

If it isn’t checked, go back to the client’s federal return and indicate on the Federal Information 
Worksheet that you want to file the client’s state return electronically.  

Once you’ve prepared the state return(s), run Final Review   as you did on the federal return. 

 

The Electronic Filing part of the Final 
Review identifies conditions in the return 
that make the return ineligible for 
electronic filing. 
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Once you’ve completed preparing the return and thoroughly reviewing it, you are now ready to 
transmit the return to the Intuit Electronic Filing Center to be distributed to the IRS and state 
taxing authorities. This is the equivalent of putting the tax return in an envelope and placing it in a 
postal mailbox for the mail carriers to deliver. 

If you elected to use the EF/Extension Ready feature in 
ProSeries, you should first mark the return or extension 
as ready to e-file by selecting the corresponding option 
from the E-file menu. 

�  A checkmark next to the menu selection(s) indicates 
that you have correctly marked the return/extension as 
Ready to E-file. 

This menu item can only be selected from within the 
client’s return. 
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If you want select several returns to transmit at once, click the EF button      on the toolbar to go 
to the EF Center in HomeBase���

 

� �To select consecutive client returns, click the first return, then hold down the SHIFT key when 

you click the last return. To select non-consecutive returns, hold down the CTRL key while you 
click each return. 

When you have highlighted the return(s) you want to transmit, click the EF Now 
button on the HomeBase toolbar. This button is active only in the HomeBase EF 
Center. Otherwise, Go to the E-File menu and choose Electronic Filing. Then 
choose Convert/Transmit Returns and Extensions. 
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The Electronic Filing Options dialog box shows the number of returns and extensions that you 
have selected for electronic filing conversion/transmission���

 

                                                         

 

Select the 3rd radio button to Convert and Transmit selected returns/extensions and Click OK. 

�  Never uncheck the Enable conversion error checking box unless you have been specifically 
directed to do so by a ProSeries technical support representative. 

When ProSeries finishes converting returns, the Electronic Filing Conversion log appears. This 
log show which returns were successfully converted and which were not, and, if a return was not 
successfully converted, lists the reason so you can make the necessary corrections. You must 
correct returns that fail the conversion process before you can convert and transmit them. If a 
return fails electronic filing conversion because there still are errors in the return, the ProSeries 
program assigns the Return Failed Final Review electronic filing status to the return. When you 
open a return that has this status, ProSeries starts Final Review automatically. 

The Intuit Electronic Filing Center manages delivery of the acknowledgments so we only send 
down acknowledgements that have not already been received. Also, the data file must be present 
on the machine and a corresponding HomeBase record displayed in the EF Center. If running two 
standalones, with the same data files on both machines, the acknowledgements will only be 
delivered to one machine automatically. If you do not receive an acknowledgment automatically, 
you can request the acknowledgements be resent via the "Update Acknowledgment Status of 
Selected Returns."  

The top two selections allow 
you to convert and transmit 
your returns at different times. 

The most common selection is 
to Convert and Transmit 
selected returns/extensions at 
the same time. 

The IRS will usually reject a 
return that cannot pass error 
checking. Don’t disable 
conversion error checking 
unless directed to do so by a 
Technical Support 
representative. 
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When you transmit an electronic return from ProSeries, it is sent to the Intuit Electronic Filing 
Center. This is not an IRS service center. 

�  For Security and Privacy purposes, you cannot recall any return or extension from the Intuit 
Electronic Filing Center. 

�  On rare occasions Intuit may contact you regarding your electronic return. To do so, we will 
use the Electronic Filing Contact Information that you completed during your electronic filing 
setup. 

The Intuit server then hosts all electronic returns for IRS and state retrieval. There is nothing you 
need to do for this to happen.  

The IRS or State Taxing Authority then sends an acknowledgement of Acceptance or Rejection 
through the Intuit server and to your EF Center. 

Each time the ProSeries program connects to the Intuit Electronic Filing Center to perform any of 
the following functions; the program also receives any available return acknowledgments: 

·  Transmit returns or extensions 

·  Task scheduler connects and you have indicated in the options to retrieve 
acknowledgements 

·  Any Bank Product related transmissions 

To manually check for any outstanding acknowledgeme nts: 

1. If you are not already in the EF Center, click the EF button
 
on the toolbar  

2. Go E-File menu 

3. Select Electronic Filing 

4. Select Receive Acknowledgement Statuses 

�

� �ProSeries automatically downloads all outstanding acknowledgements each to you e-file a 

return or check for updates. 
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Particularly if you are filing returns electronically (and thus automatically receiving 
acknowledgements) from multiple stand-alone computers, you can avoid issues receiving 
acknowledgements from each of those computers using the Update Acknowledgement status of 
Selected Returns 

�

If you highlighted the specific client file(s) prior to selection this program function, you can request 
ProSeries to update those selected return/extension acknowledgements with the first�option of�the 
following screen��

��

Otherwise you can select to update all pending returns and extensions. 

By using this option, ProSeries will search your database for all returns/extensions that show a 
pending status (i.e. Transmitted, Received by Intuit, Sent to taxing authority or Delayed), and 
download all of those acknowledgements. 

This is different from the standard “Receive Acknowledgement Statuses” function which simply 
looks on intuit servers for which acknowledgements that have not yet been downloaded by any 
computer. 
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Once the IRS or State Taxing Authority accepts the tax return, no further electronic transmissions 
are required (unless your client is using a Bank Product).  

The status column in your EF Center now reads “Accepted” or “Accepted with PIN” to indicate 
that the IRS has acknowledged your client’s election of the PIN program. If the status column 
does not read “Accepted with PIN”, the IRS will expect that you will mail Form 8453. 

If your client elected direct deposit on an expected refund, you can determine the date the deposit 
will be made once it is accepted. Go to ProSeries.com and search for IRS Refund Cycle. 

If you filed a balance-due return and your client did not elect to have their bank account directly 
debited, print Form 1040-V, Balance Due Payment Voucher and give it to your client. If your client 
owes state taxes, complete the state tax payment voucher at the same time. 

�  If your client owes federal taxes, he or she must mail Form 1040-V and the payment to the 

IRS no later than April 15, 2007.  

Review common rejection reasons, troubleshooting information, and frequently-asked questions 
at ProSeries.com, go to the EF Center in ProSeries, then click the View Frequently Asked EF 
Questions button. Alternatively, go to www.ProSeries.com and click E-Filing. You can also use 
this page to obtain electronic filing status information on your clients’ returns. 

�
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The IRS or State Taxing Authority may reject certain returns for a number of different reasons. 
Typically, you then have the ability to correct the issue causing the rejection and E-file the return 
electronically. In this case, you cannot file OR, HI or OK returns electronically unless the federal 
return was rejected as well since they are strictly Fed/State states. 

When a return is rejected, the status column in the EF Center changes to “Rejected” click the 
hyperlink to see the Rejected Returns Report. Then correct the errors make sure the return 
passes Final Review and file the tax return again. 

Discover helpful and important tips for trouble-free electronic filing in the ProSeries Help Center. 
Press [F1] while you are in the EF Center. Click Filing returns electronically under the Filing 
returns heading of the Program Help section. Then click Tips for trouble-free electronic filing 
under the Other useful information heading. 
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One of the benefits of filing electronically is that you discover is something is wrong with a tax 
return within a few days time (instead of weeks, months or even years). Nonetheless you still 
want to avoid rejections as they delay the processing of your clients return. 

Here are some common reasons returns may get rejected and how to avoid them: 

·  Verify the client’s social security number (SSN), name on record, and Date of Birth (DOB) 
with the Social Security Administration (SSA). 

·  If you’re preparing a Married Filing Joint return, verify that the spouse’s last name on the 
return matches the spouse’s last name on his or her Social Security card. 

·  Make sure the employer’s name and federal identification number on the actual Form W-
2 match the information you’ve entered in the return. 

·  Make sure the payer’s name and federal identification number on the actual Form W-2G 
or Form 1099-R match the information you’ve entered in the return. 

·  Use the error-checking feature during data entry. Go to the View menu and make sure 
there’s a check mark before Error Alerts. 
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Electronic filing statuses reflect the current status of a return (or extension) that will be or has 
been filed electronically. The current status for a return (or extension) appears in the Status 
column in the HomeBase EF Center. 

�

The most common status messages for returns (and their meanings) include: 

·  Return Transferred for EF: This status is assigned to all returns that were filed 
electronically in the prior year that have been transferred but not yet opened. 

·  Return Marked for EF: The File the Federal Return Electronically box is checked on the 
Federal Information Worksheet. If the return was transferred from a prior year, this status 
is assigned once the return has been opened and saved. 

·  Return Duplicate SSN: At least one other return or extension in the HomeBase EF Center 
shares the primary Social Security number (SSN) in this return. 

·  Return Duplicate DCN: At least one other return or extension in the HomeBase EF 
Center shares the Declaration Control Number (DCN) in this return. 

·  Return Transmitted: The return has been transmitted to the Intuit Electronic Filing Center 
using ProSeries. 

·  Return Sent to IRS: The Intuit Electronic Filing Center has forwarded the return to the 
IRS. 

·  Return Sent to State: The Intuit Electronic Filing Center has forwarded the return to the 
state taxing authority. 

·  Return Accepted: The IRS or state taxing authority accepted the return. 

·  Return Rejected: The IRS or state taxing authority did not accept the return. 

·  Delayed: Alerts you that the return has been flagged by Intuit indicating that we have 
identified that the taxing authority has not sent an acknowledgement within the typical 
range of time in which they usually send one and we are tracking it. 

·  Received by Intuit: Let’s you know that the Intuit Electronic Filing Center has received the 
return but that it has not yet been forwarded to the State/Federal authority. 

�  The IRS and state taxing authorities have different regulations around electronic filing. If you 
electronically file a client's federal return and a state return, the acknowledgments that you 
receive for each return may be different. For example, a client's federal return may be "Accepted" 
though the state return is "Rejected." 

For a complete list of these status messages and a list of status messages for extensions, review 
the ProSeries Program Help. 
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The HomeBase EF Center includes three tabs below the HomeBase View field���

�

·  All - Select the All tab to see all returns that have been marked for electronic filing. 

·  Pending - Select the Pending tab to see all the returns that have been marked for 
electronic filing and that don't have a status of Accepted. 

·  Accepted - Select the Accepted tab to see all the returns that have been marked for 
electronic filing and that have a status of Accepted. 

 

The first time you go to the EF Center, the Pending tab is selected. When you return to the EF 
Center, the tab that was selected when you last exited the EF Center is selected.  

�  Click the Accepted tab and click the status date column to sort the EF Center showing returns 
that were accepted most recently at the top. Now you can easily identify which clients are ready 
to be closed (i.e. give them Form 9325, final consultation or phone call, etc.) 
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Form 9325 contains important information regarding your client's return and should be given to 
them with their copy of the printed return. Form 9325 populates based upon information returned 
within the acknowledgment. This information is "stored" until the return is opened since receiving 
an acknowledgement for it. The information then calculates through to the return's Form 9325.  
This only applies to individual income tax returns. 

Line 1 is used to inform you about which IRS service center will process your client's electronic 
return.  

Line 2 states the date on which the IRS accepted your client's electronic return and the 
Declaration Control Number (DCN) assigned to your client's electronic return.  

Line 3 contains the Debt Indicator Checkbox and the informational text under Line 3 provides a 
brief explanation of the Debt Indicator meaning. A detailed explanation of the Debt Indicator is 
provided farther down in this help.  

Lines 4 and 5 provide information on your client's PIN and electronic funds withdrawal elections 
and the IRS' response to those requests.  

Line 6 is not supported for electronic filing by ProSeries��

�
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Indicates the IRS has withheld part or all of your client's refund to offset a debt owed. The IRS 
Acknowledgement contains the Debt Indicator values, which are also shown in the EF Center. 

�  The IRS advises that it offers no guarantee about any offset of a refund. This means that even 
though no offset was indicated at the time of the Acknowledgement's transmission, if a 
subsequent offset becomes indicated prior to the IRS' issuance of a refund, the refund may be 
offset. If you or your client have any questions about the status of the refund and/or any pending 
offsets, please call the IRS directly at 1-800-829-1040. 

This Debt Indicator Code Explanation displays immediately below the Line 3 checkbox. If the 
client is due a refund, this provides an explanation of why the IRS has withheld part or all of your 
client's refund to offset a debt owed. 

The possible values can be found in the ProSeries Tax Help by pressing F1 while you are on 
Form 9325. 

�  ProSeries provides a debt indicator column in HomeBase for quick reference without having to 
open the client’s return. 
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